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Safe harbor statement

During the course of this presentation, we may make statements regarding future
events and/or statements regarding planned or future development efforts for our
existing or new products and services. We wish to caution you that such
statements reflect our current expectations, estimates and assumptions based on
factors currently known to us and that actual events or results could differ
materially. Also, these statements are not intended to be a promise or guarantee
of future delivery of products, services or features but merely reflect our current
plans, which may change. Purchasing decisions should not be made based upon
reliance on these statements. The statements made in this presentation are being
made as of the time and date of its live presentation. We do not assume any
obligation to update any statements we make to reflect events that occur or
circumstances that exist after the date of this presentation.
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Coordinate System?

Coordinate System: What? Why? How?



Why we need a coordinate system?

Geoid
A less lumpy mathematical 
approximation of the earth

GIS Coordinate System (lat, long)
In geodesy, a reference ellipsoid is a 
mathematically defined surface that 
approximates the geoid, the truer 
figure of the Earth

Projected Coordinate System (ft, km)
Planner (cartesian) coordinates are 
the way of assigning a set of 
Coordinates to locations

Datum:

There are many ellipsoids you can use to reference locations of 
the earth with latitude and longitude, these different geographic 
coordinate systems are called datums. Certain datums fit different 
parts of the lumpy earth better than others, so changing datums 
can make measurements more accurate depending on where 
you are

For nearly all basic mapping, however, there are three datums 
that are all you need to know; WGS84, NAD 83 and ITRF00

Projections:

The world is a three dimensional (3D) ellipsoid but almost all the media 
we work with is 2 dimensional (2D) and In order to transform these 
latitude and longitude (spherical) coordinates into meaningful units, the 
datum must be transferred to a planar (cartesian) coordinate system. 
There are many ways to do this, and these are called projections

There are three ways to transfer the curved surface of the ellipsoid to a 
flat plane, you can make Cylindrical, Conic or Planar (azimuthal), 
projections

In order to make different measurements-distance, area, shape, or 
direction-you must choose the best projection for the job

Actual Earth
A very Lumpy object that has 
topography, bathymetry, 
Changing ocean height, etc..

PlanarEllipsoid

Non circular/ellipsoidal undulated shape of Earth needs coordinate system !!



The origins of the WGS84 and NAD83 ellipsoids are at the center of the earth’s mass, which 
makes them ideal for a GPS datum

Why WGS84 is the most common Datum ?
WGS84: WGS84 ellipsoid origin center of earth

https://confluence.qps.nl/qinsy/en/world-geodetic-system-1984-wgs84-29855173.html


Latitude and Longitude
Spherical coordinate system of the globe can be expressed as Latitude & Longitude

Lat: 40o 00’ 00.00’’
Long: 50o 00’ 00.00’’

§ Latitude lines run east-west and are parallel to 
each other. If you go further north, latitude values 
increase. Finally, latitude values (Y-values) range 
between -90 and +90 degrees

§ Longitude lines run north-south. They converge at 
the poles. And its X-coordinates are between -180 
and +180 degrees



Why we need Projected coordinate system

§ GIS Coordinate System : LL84 
§ Reference/Datum : WGS84 (World Geodetic System of 1984, 

Spheroid)
§ Ellipsoid : WGS84 (World Geodetic System of 1984, GEM 10C)

§ Measurement Unit : Degree
§ Representation : Latitude-Longitude

§ Projected Coordinate System : UTM84-43N
§ Projection : Universal Transverse Mercator System 
§ Reference/Datum : WGS84 (World Geodetic System of 1984, 

Spheroid)
§ Ellipsoid : WGS84 (World Geodetic System of 1984, GEM 10C)

§ Measurement Unit : Meter
§ Representation : Latitude-Longitude

The Coordinate system that is used to draw the earth on a flat map 



UTM Grid Zones of the World
Global view of UTM grids (notice – Distortion minimized in a N-S “Strip” ZONE)



UTM Grid Zones of the World
How to find in which UTM projected coordinate system grid your site situated in? 



UTM Grid Zones of the World
Site view from Lat long & UTM perspective



Coordinate System?

Understand Coordinate System by Products



VERTICAL 

HORIZONTAL 

Why it is Important to Understand the Difference
Linear & Vertical project has different requirement

How it is located and built on Earth
§ Length, area, and height of project
§ Elevation on earth

§ Location and orientation
Design constraints

§ Shape of Earth vs. flat design plane
§ Local vs. assumed coordinate systems
§ Double vs. single precision applications
§ Orthogonal vs. meandering



VERTICAL = Revit 

HORIZONTAL = Civil 3D 

Linear & Vertical project has different requirement
Important to Understand the Difference in Applications

Design Authoring Applications
§ Revit – Vertical Projects
§ Civil 3D – Horizontal Projects

§ Infraworks - Both

Design Review and Federation Applications
• Navisworks Manage for clash functions
§ Infraworks
• Visualization 



Geospatial coordinate values are long & not all Autodesk products are geospatially aware:

Single-precision
☒ 3DS Max
☒ Revit
☒ Inventor

Double-precision
AutoCAD
Civil 3D
InfraWorks
ReCap
Navisworks

All because of precisions
Being geospatially aware as your product may not be!



§ There are pitfalls associated with 
the exchange of data between 
single and double precision 
coordinate system, specifically 
the degradation of your dataset

§ This example occurs when direct 
import of a double precision 
dataset into a single precision 
product

§ This demonstrates very 
succinctly what can happen to 
your data if not translated in a 
double precision environment 
first

All because of precisions
Degradation of Data
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Collaborate with Civil 3D

Workflows: Infraworks to Civil 3D



Workflow - Import data from Infraworks to Civil 3D
When importing IMX/*.Sqlite,  set Coordinate system first!

For a visual verification of the 
Coordinate System…

§ In ToolSpace, select the 
settings tab and right click the 
DWG name. Select edit 
drawing settings

§ In the Units and Zone tab of 
the Drawing Settings dialog 
box, you will need to make 
sure the correct Coordinate 
System is set up

§ Later apply same Coordinate 
System when importing AIW* 
Model



Workflow - Import data from Infraworks to Civil 3D
Export project boundary as *.shp/*.sdf (Optional)

§Open “Project_Boundary.dwg” & use 
command: “mapexport” to export the 
project boundary as shp/sdf format
§Window>Section>Pick polyline from the 
window and select the geometry by 
selection or layer
§Window>Data>Select Attribute (If any)
§Window>Options>check the “Treat closed 
polyline as polygons” so that this geometry 
will be treated as polygon not polyline, 
Click OK
§Area must be less than 200sqkm



Workflow - Import data from Infraworks to Civil 3D
Use model Builder to create Infraworks model

§Open Model Builder & Click on “Import a 
polygon to select an AOI” >Select the 
“Project_Boundary *.shp & *.Prj” (Or Type 
“Mount Abu”>Search)
§Make sure the area of project boundary is 
less than 200sq. km
§Give model name “Mount_Abu_Project” & 
click>create Model
§Once the model is downloaded you will 
receive an email notification
§Choose: Where would you like to store this 
model? BIM 360 or local drive



Workflow - Import data from Infraworks to Civil 3D
Import AIW Model in to Civil 3D

§ Check if the projected coordinate system 
is applied in “Project_Boundary.dwg”

§ Close Infraworks software & open 
Infraworks model from Civil 3D 
“Infraworks Tab” and browse your model 
from “Documents\Autodesk InfraWorks 
Models\Autodesk 360\xxxxx” path

§ Import the “Extents of InfraWorks model” 
or “Area Of Interest”

§ Create/Configure the layers and other 
necessary settings from the “Object 
Settings” & “OK” > “Open Model”

§ You may import using IMX format



Collaborate with Civil 3D

Workflows: Revit to Civil 3D



Workflow - Import Data from Revit to Civil 3D

§ File>Export>CAD Formats>DWG

§ Create a new Set to add the views, 
Which you want to export 

§ Check all or desire views to export as 
drawings

§ And to Modify Export Setup, Click > 
ExportSetup,    (Disabled entities from 
Visibility Graphics won’t appear here)

§ You can also choose desire options from 
tabs like Layers, Lines, Color, etc

You can save setup settings to use in other Revit projects



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

§ Tab > Layer > Choose: Export Layer 
options

§ Tab > Layer > Choose: Load layers from 
Standards



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

§ Tab > Solid > Choose: ACIS solids 



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

§ Tab > Units & Coordinates > Choose > 
Meter & Shared CS

§ Click OK & Next/Save set and close



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

§ Choose > Output folder location

§ Choose > AutoCAD Drawing Version

§ Choose > Short name / Long suffix is 
also available to choose for naming

§ Tick > Export views on sheet and links as 
external references



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

All the sheets are now stored in to the 
desire folder location



Workflow - Import Data from Revit to Civil 3D
You can save setup settings to use in other Revit projects

Open Drawing file in AutoCAD
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§ RW01 - Assign Coordinates in Revit 
(With/Without CAD Drawing)

§ RW02 - Import LandXML Using Site 
Designer

§ RW03 - Acquire coordinates

§ RW04 - Publish coordinate from 
Revit to DWG

Revit Workflows
Interoperability between Revit and other products



Collaborate with Revit

(RW01):
Assign Coordinates in Revit (With/Without CAD Drawing)



Assign Coordinates in Revit
Survey point is the key!

§ Define the survey point coordinates 
values to match a known point in the 
physical world

§ Use survey point coordinates from the 
civil engineer, or determine the 
coordinates of a known location, such as 
a geodetic survey marker or benchmark 
or the intersection of 2 property lines

§ Project base point will automatically be 
updated to establish a reference for 
measuring distances and positioning 
objects within the context of the model



Assign Coordinates in Revit
Make sure you are using the correct units!

§ As civil engineers work with specific 
units, you may want to consider to 
change the units in your Revit project in 
order to be aligned with them (Manage
tab > Settings > Projects Units)



Assign Coordinates in Revit
Display the survey point

§ Go to any floor plan 
(Site plan recommended)

§ Open “Visibility and Graphic Display“ 
dialog

§ Display survey point

§ Display project base point (optional)

§ Revit internal origin, Project Base 
Point and Survey Point are 
at the starting of a project all situated in the 
same place (0,0,0)



Assign Coordinates in Revit
Define real world coordinates to the survey point (N/S and E/W)

§ Unclip survey point in order to define the 
right coordinate values

§ Define N/S (northing) and E/W (easting) 
values of a desired location

§ N/S=Y, E/W=X, Elev=Z

§ Survey point will move to a new position. 
Do not worry about the current position of 
the survey point in the floor plan

N/S=2712096.377 m, E/W=273316.399 m
Elev=274.000 m



Assign Coordinates in Revit
Define real world coordinates to the survey point (Elevation)

§ Display survey point (and project base 
point) in an elevation view

§ Define elevation value (survey point is still 
unclipped)

§ Moving an unclipped survey point moves 
only the survey point relative to the shared 
coordinate and the project coordinate 
systems:
§ Project coordinates do not change for 

the model elements
§ Shared coordinates do not change for 

the model elements
§ Only the shared coordinates of the 

survey point itself change



Assign Coordinates in Revit
Place the survey point at the desired location (N/S and E/W)

§ Clip survey point

§ Move the survey point to the desired 
location (provided by civil engineer) in a 
floor plan matching with the values we just 
defined

§ N/S (northing), E/W (easting), and 
elevation values have not changed



Assign Coordinates in Revit
Place the survey point at the desired elevation

§ Move the survey point to the desired 
elevation in an elevation or section view 
matching with the value we just defined 
(survey point is still clipped)

§ N/S (northing), E/W (easting), and 
elevation values have not changed

§ Moving a clipped survey point repositions 
the shared coordinate system relative to 
the model geometry and the project 
coordinate system:
§ Project coordinates do not change for 

the model elements
§ Shared coordinates change for the 

model elements



Assign Coordinates in Revit
Check it & Pin it!

§ Check different spots coordinates of 
known geographical points to make sure 
the workflow was correctly 
done (Annotate tab > Dimensions panel 
> Spot Coordinate)

§ Pin it (optional) to ensure that the Survey 
Point does not move inadvertently    
(Modify tab > Modify panel > Pin)

§ Create a 3D view and name it with 
"navis" prefix as InfraWorks looks for a 
Revit view with this name to import first. 
In this view you can control the elements 
transferred turning off the categories that 
are not needed



Assign Coordinates in Revit
Video – Assign projected coordinates in Revit model to the Survey Point



Collaborate with Revit

(RW02):
Import LandXML Using Site Designer



§ You can share a site model between Revit and 
AutoCAD Civil 3D through LandXML files

§ LandXML is co-developed by Autodesk

§ Revit supports imported XML, using Site Designer

§ Site Designer for Revit® is an extension (add-in) for 
the Revit software. It is available to Autodesk 
subscribers of a supported Revit product or suite

§ For this workflow you will need:
§ Civil 3D
§ Revit
§ Revit add-in Site Designer

Import LandXML Using Site Designer
Overview

LandXML

Site Designer



§ The LandXML import and export 
functionality is based on the LandXML 
schema. Autodesk Civil 3D supports the 
following LandXML schema versions:
§ LandXML-1.0, 1.1, 1.2

§ Export a LandXML topography using 
following steps:
§ Output tab > Export to LandXML
§ Check or uncheck the boxes to filter the 

data that you want to export
§ Use Pick from drawing tool to select 

data manually
§ Specify the LandXML schema version

Import LandXML Using Site Designer
What to do in Civil 3D



Import LandXML Using Site Designer
Assign coordinate system into Revit

§ Before you import LandXML file into Revit you 
need to assign coordinate system into your Revit 
model

§ The workflow “Assign coordinate system into 
Revit“ is covered by the workflow RW01 of this 
accelerator

§ In order to understand how the geo-referenced 
coordinates can be applied in Revit, we strongly 
recommend to watch workflow RW01 materials

§ Finally, for the import of LandXML you can use the 
Revit file from RW01 which is already prepared 
and contains the assigned geo-referenced 
coordinate system, aligned with the Civil 
3D model



Import LandXML Using Site Designer
How to import LandXML toposurface in Revit

§ Start Revit and open the prepared file
§ Tab > Site Designer
§ Click on Import LandXML
§ Select the LandXML file to import
§ Uncheck the “Import alignments found in 

LandXML file”, unless you exported alignments 
with your Civil 3D LandXML file

§ Set Positioning to “By Survey Point”
§ Then click OK



Import LandXML Using Site Designer
How to import LandXML toposurface in Revit

§ Select the toposurface you need to import, if the 
LandXML contains more than one

§ Rename the toposurface if needed
§ Assign the toposurface to a specific project phase
§ Import the toposurface



§ Open the view > Floor Plan > Site

§ The toposurface should be located at 
the correct position

§ Note: when importing topography via 
LandXML, Revit retriangulates the 
toposurface and it could create less 
accurate surface, so make sure to 
double-check the final result

Import LandXML Using Site Designer
How to import LandXML toposurface in Revit



Import LandXML Using Site Designer
Video – Import a LandXML toposurface in Revit 



Collaborate with Revit

(RW03): 
Acquire Coordinates



§ To streamline the process of developing, using, and 
sharing topography data for a project, Revit 
supports interoperability workflows with Civil 3D

§ When a civil engineer creates topography data for a 
project and you want to reference it for a building 
model, you can link the topography to Revit

§ For this workflow you need following 
products/services:
§ Civil 3D
§ BIM 360 Docs
§ Autodesk Desktop Connector
§ Revit

Link Civil 3D Topography in Revit
Civil 3D to Revit



§ Develop the topography

§ Publish surfaces to a BIM 360 project:
§ Open the drawing with required 

topography
§ Collaborate tab > Publish surfaces
§ Select a surface to export
§ Specify the output file
§ Publish the existing surface for further 

use in Revit or BIM 360

Link Civil 3D Topography in Revit
The civil engineer uses Civil 3D to do the following:



§ Open your BIM 360 project & open the 
Document Management module

§ Open the directory with the published topography

§ Open the shared DWG file

§ As for all documents in BIM 360 you can:
§ Create mark-ups
§ View properties
§ Compare different versions
§ Section 3D drawing/model
§ Etc…

Link Civil 3D Topography in Revit
What to do in BIM360 Docs



§ Start Revit and go to the Insert tab

§ Link > Link Topography

§ Pick up the topography in BIM 360 project

§ Link the chosen topography

§ Close the Differing Coordinate Systems 
warning, Revit will assign the coordinates 
automatically, usually using “Center-to-Center”

§ Important - For the other workflows do not 
insert/link CAD drawing or Revit model "By 
Shared Coordinates" when linking first time!

Link Civil 3D Topography in Revit
What to do in Revit



§ Following steps showing acquiring coordinates 
are valid for any C3D topography (via BIM360) 
or DWG files

§ When you want to link a Civil 3D DWG file 
directly, make sure to set the 
PROXYGRAPHICS=1 in Civil 3D 

§ Go to a Floor Plan (Site Plan recommended)

§ Zoom All

§ Now you can see the linked topography

Link Civil 3D Topography in Revit
Acquire the coordinates from Civil 3D topography or a DWG



Assign Coordinates in Revit
Display the survey point

§ Go to any floor plan 
(site plan recommended)

§ Open “Visibility and Graphic Display“ 
dialog

§ Display survey point

§ Display project base point (optional)

§ Revit internal origin, project base 
point and survey point are 
at the starting of a project all situated in the 
same place (0,0,0)



Link Civil 3D Topography in Revit
Moving topography

§Drag or Move the linked topography to the 
desired location (the corner of a property 
line, etc.) in a Floor Plan
§Drag or Move the linked topography to the 
desired location (the corner of a property 
line, etc.) in Elevation or Section



Link Civil 3D Topography in Revit
Acquire coordinates from a linked file

§ After you positioned the linked 
topography/DWG at the desired location, 
we can start with acquiring coordinates

§ Go to Manage > Project Location > 
Coordinates > Acquire Coordinates

§ Select the linked file

§ Now the coordinates from the linked file 
are acquired 

§ Select the Project Base Point and check 
the modified coordinate values

§ The Survey Point should still be at 0,0,0



Link Civil 3D Topography in Revit
Removing the link

§ In order to control the successful acquiring 
of coordinates, remove the linked 
topography/DWG and re-link it:
§ Manage > Manage Links > 

Topography/CAD Formats
§ Select the linked file and remove it

§ This step is not only for checking, it is 
necessary for the DWG in order to get the 
file linked by newly created Shared 
Coordinates



Link Civil 3D Topography in Revit
Re-linking by Shared Coordinates

§ Now re-link the topography/DWG

§ For the topography the linking will be handled 
automatically by Revit

§ For the DWG use the option “Auto – by Shared 
Coordinates”

§ Finally the re-linked file should appear at the 
correct location, specified in the previous steps 
without any manual adjusting



Link Civil 3D Topography in Revit
Reloading a new version of topography

§ The BIM 360 workflow 
greatly improves the workflow for 
topography transfer from civil 
engineers to architects

§ You can make changes in Civil 3D 
and then upload as described in the 
previous process to BIM 360

§ In Revit, just use reload or reload 
from and link topography again



Link Civil 3D Topography in Revit
What method assures the best representation?

§ Using the Link Topography workflow 
assures an accurate representation of 
topography from Civil 3D surfaces in Revit. 
Compare the results of the same surface 
data in the images below:

TIN triangulation 
is maintained

USING TRADITIONAL 
IMPORT METHODS

USING NEW LINK TOPOGRAPHY

Boundaries and 
cut-outs remain

Break lines, steep 
slopes and fills are 
not destroyed



Link Civil 3D Topography in Revit
Video – Linking Civil 3D topography in Revit using BIM 360



Collaborate with Revit

(RW04):
Publish Coordinates from Revit to DWG



Publish Coordinates from Revit to DWG
Get your models and drawings files easily connected to Revit

§ When you publish shared coordinates from 
a host model to a link, the linked 
model/drawing is updated with the new 
coordinates

§ The host model's True North and shared 
origin are recorded in the linked 
model/drawing, based on the current 
position of the linked instance

§ This location is now applied in both host 
model and the link. More than one position 
of the link can be created and used

§ The shared coordinates establish the 
relative locations of the models or 
drawings



Publish Coordinates from Revit to DWG
Bring the DWG to correct place in the Revit model

§ This workflow continues from RW01 as the
Revit model has been already relocated by 
specifying coordinates

§ Now we can publish the Revit model real 
world coordinates to AutoCAD drawing (or 
another Revit model)

§ Start with the model, used for the workflow 
RW01

§ Link DWG into Revit using “Center to 
Center” 

§ Align/rotate/move to the right position



Publish Coordinates from Revit to DWG
Publish Coordinates

§ Publish Coordinates to the DWG               
> Manage tab > Project Location menu > 
Coordinates > Publish Coordinates

§ Click OK & save the Revit file

§ Save – save the new position back to the 
link (DWG/Revit files must be close)

§ Remove the link and re-link it using “Auto –
By Shared Coordinates” 

§ Finally the re-linked file should appear at 
the correct location, specified in the 
previous steps without any manual 
adjusting



Publish Coordinates from Revit to DWG
Check the coordinates from the link instance 

§ Open the linked file and change the UCS 
coordinate system to the Revit exported 
coordinates system:
§ Select & right click the UCS icon
§ Choose > Named UCS > Revit60-

DefaultLocation

§ Use Command: Plan > current UCS

§ Home tab > Utilities menu > ID Point and 
pick a known geographical point to make 
sure the workflow was correctly done

§ Nothing is moved/rotated in AutoCAD



Publish Coordinates from Revit to DWG
Video – Publish coordinates from Revit to a linked DWG



Collaborate with Revit

Prepare your Revit Model for Exporting Out



§ We recommend to create a 3D view and name it with 
"navis" prefix as Navisworks and InfraWorks look for 
a Revit view with this name to import first

§ In this view you can control the elements transferred 
turning off the categories that are not needed

§ That way you can easily control the LOD (level of 
detail) of your exported model and facilitate the 
import of Revit models in other applications

Prepare your Revit Model for Exporting Out
Custom 3D view for exporting



§ Revit > Export > NWC

§ Navisworks Options > File Readers

§ Revit > Coordinates

§ You have following options at 
Coordinates:
§ Project internal
§ Shared

§ We usually recommend to work with 
the default option “Shared” (which 
means Shared Coordinates)

Prepare your Revit Model for Exporting Out
Export to Navisworks



§ Revit > Export > IFC

§ Modify Setup > General

§ You have following options at Project 
Origin:
§ Current shared coordinates
§ Site survey point
§ Project base point
§ Internal coordinates

§ We usually recommend to work with 
the default option “Current shared 
coordinates”

Prepare your Revit Model for Exporting Out
Export to IFC
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Collaborate with Infraworks

Import AEC Model to InfraWorks



Import AEC Model to InfraWorks
Best practices to bring your AEC model into InfraWorks

Buildings Data 

§ IW01-Import Revit models (*.rvt)
§ Cloud Import
§ Local Import

§ IW02-Import IFC models (*.ifc)
§ Cloud Import

§ IW03-Import 3D model (.fbx)
§ Local Import

Infrastructure Data
§IW04-Import IMX to InfraWorks
§Local Import

§IW05-Import LandXML to InfraWorks
§Local Import

§IW06-Import Civil 3D Drawing to 
InfraWorks
§Local Import



Collaborate with Infraworks

(IW01):
Import Revit Model into InfraWorks



Import Revit Model into InfraWorks
To set data import option to local or cloud

§ By default, file conversion is processed in 
the cloud for many file formats

§ Use Application Options to enable/disable 
local Import for supported formats
§ Cloud import
§ Local import

§ For Local import it is required to have 
installed same version of Navisworks 
Manage or Simulate as InfraWorks

§ Click      > > Data Import > Checkmark 
Navisworks based Local Import



Import Revit Model into InfraWorks
Import your Revit (*.rvt) file with local import

§ Check Naviswork based Local import 
option

§ In InfraWorks, click       > >

§ On the Data Sources panel
§ Click (Add File Data Source)
§ Click Autodesk Revit
§ Open the Revit model file

§ If prompted, in the Data Import dialog, click 
Send

§ When the model is finished processing, it 
displays under Buildings in the data 
sources list



Import Revit Model into InfraWorks
Configure your Revit (*.rvt) file with local import

§ Double-click the data source to configure it

§ Geolocation Tab: InfraWorks transforms 
project coordinates to geographical 
coordinates

§ Define the insertion point: choose the 
desired coordinates system and change 
coordinates to X=0, Y=0, Z=0

§ 3D Model tab: check the geometry is 
correctly displayed. You may want to use 
LOD for big models. Close & Refresh

§ Zoom in: Big models geometry elements 
becomes less reliable and less accurate so 
distortion may be seen



Import Revit Model into InfraWorks
Import your Revit (*.rvt) file with cloud import

§ Disable Navisworks based Local import 
option

§ Repeat the same process as before to 
import the Revit model



Import Revit Model into InfraWorks
Configure your Revit (*.rvt) file with cloud import

§ Double-click the data source to configure it

§ Geolocation Tab: warning pops-up. 
InfraWorks does not read the project 
coordinates system from Revit

§ Define insertion point: choose the desired 
coordinates system & change coordinates 
to X=0, Y=0, Z=0. Offset using the 
coordinates of the Revit Internal Origin

§ 3D Model tab: check the geometry is 
correctly displayed. Close & Refresh

§ The model displays in the correct place 
and geometry is correct



Collaborate with Infraworks

(IW02):
Import IFC Model into InfraWorks



Import IFC Model into InfraWorks
Import your IFC model with cloud Import

§ Export IFC file from Revit

§ Use cloud import     to bring IFC models 
into InfraWorks. Click      > > Data 
Import > Navisworks based Local Import 
should be unchecked

§ In InfraWorks, click       > >

§ On the Data Sources panel
§ Click (Add File Data Source)
§ Click IFC
§ Open the IFC file

§ When the model is finished processing, it 
displays under Building in the data sources



Import IFC Model into InfraWorks
Configure your IFC model with cloud Import

§ Double-click the data source to configure it

§ Geolocation Tab: warning pops-up. 
InfraWorks is not able to transform 
coordinates system from IFC

§ Define insertion point: choose the desired 
coordinates system and change 
coordinates to X=0, Y=0, Z=0 (*)

§ 3D Model tab: check the geometry. The 
graphical representation of elements 
becomes not reliable and not accurate 
because the model is significantly far away 
the origin 0,0,0 (*)

§ Close & Refresh (*)



Import IFC Model into InfraWorks
Do it correctly

§ Make a copy of *.rvt model & change 
survey point coordinates values to 0,0,0 
and bring it back to same position clipped

§ Repeat process to export and import IFC

§ Ignore geolocation warnings. Choose the 
desired coordinates system and change 
coordinates to X=0, Y=0, Z=0. Offset using 
the coordinates of the survey point as we 
chose same, while exporting IFC

§ 3D Model tab: check the geometry is 
correctly displayed. Close & Refresh

§ The model displays in the correct place 
and geometry is correct



Collaborate with Infraworks

(IW03):
Import FBX Model into InfraWorks



Import FBX Model into InfraWorks
Import your 3D model with local import

§ Export FBX file from Revit. You may want 
to use LOD for big models

§ In InfraWorks, click       >       >

§ On the Data Sources panel
§ Click (Add File Data Source)
§ Click 3D Model
§ Open the FBX file

§ When the model is finished processing, it 
displays under <No Feature Type> in the 
data sources list

§ It will be always using local import      to 
bring 3D models into InfraWorks



Import FBX Model into InfraWorks
Configure your 3D model with local import

§ Double-click the data source to configure it

§ Some warnings pop-up. InfraWorks does 
not read the project coordinates system 
from the .fbx exported from Revit

§ Change Type to Buildings

§ Geolocation Tab: define insertion point. 
Choose the desired coordinates system 
and change coordinates to X=0, Y=0, Z=0. 
Offset using the coordinates of the Revit 
Internal Origin

§ 3D Model tab: check the geometry is 
correctly displayed. You may want to use 
LOD for big models. Close & Refresh



Import FBX Model into InfraWorks
Open Data model (*.ifc) / Revit model (*.rvt) / 3D model (*.fbx)

.ifc .rvt .fbx

Auto Positioning    
(With Local Import)

✅ ✅ ✖

Offset Positioning ✅ ✅ ✅
Reduced File Size ✅ ✖ ✅

Fast Process ✅ ✖ ✅
Texture Import ✖ ✅ ✅
BIM Exchange 

Extension
✅ ✅ ✖

Prevent Data lost ✖ ✅ ✖



Collaborate with Infraworks

(IW04):
IMX to InfraWorks



Data Import in InfraWorks
InfraWorks displays the added data as InfraWorks features

Autodesk Civil 3D drawing object becomes... InfraWorks model object Notes
TIN surfaces Terrain surfaces •Each surface is listed in the Data Sources panel.

•Click to adjust the order of terrain surface layers.
Alignments and profiles Component roads (horizontal and vertical geometry) •Only Centerline type alignments can be brought in as component roads.

•A single profile is used for each component road, based upon the first finished ground profile that 
was created in the Autodesk Civil 3D drawing. Use Profile View to review the profile geometry.
•Best fit profile entities are not brought into InfraWorks.

Corridors and Corridor surfaces Coverages and terrain surfaces •We recommended that you create one or more corridor surfaces in Autodesk Civil 3D to bring 
into InfraWorks.
•Autodesk Civil 3D link styles are used to create coverages in InfraWorks which show the materials of 
the corridor. The coverages allow you to stylize the different corridor components like pavement.
Important: Coverage areas are only created in InfraWorks for link codes within a code set style that 
have a render material assigned inAutodesk Civil 3D. The link styles are used as TAG expressions 
when imported to InfraWorks.

Pipe Networks Pipelines with inlets and manholes or pipeline connectors •If a structure in the Autodesk Civil 3D drawing has a Drainage Utility Type specified and is using the 
new default parts catalog with component object parts for pipeline connectors, InfraWorkswill use 
the same component object parts. When there is no match of pipeline connector parts, generic 
objects are displayed.

https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-RoadsandHighways/files/GUID-16C4D630-A4C4-4BC6-9365-DDEC802FE4F9-htm.html


IMX to InfraWorks
Just import & configure

§ Use Command: IMX_Export or use 
InfraWorks>Export IMX from Civil 3D

§InfraWorks > Data Sources panel > Add File 
Data Source > Click Autodesk IMX
§Select the feature classes to import “Each 
feature class will appear under its respective 
category in the Data Sources list. For example, 
select Pipelines if you are importing 
pipes, Roads if you are importing a 
corridor/Alignment, or Terrain if you are 
importing a surface.”
§Design Road/Alignment will come as a 
centerline & Surface as Terrain (no grading)

https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-UserHelp/files/GUID-B0CE8D89-F17D-422F-8EF9-DA17838F3CE4-htm.html


InfraWorks Workflow-05 (IW05):
LandXML to InfraWorks



LandXML to InfraWorks
Export from Civil 3D

§Output tab > Export panel > Export 
to LandXML
§Select Civil 3D objects to be included like 
Point Groups, Surfaces, Alignments and 
Profiles, Sites, Pipe Networks, Pressure 
Networks, Corridors
§Specify LandXML version- 1.0, 1.1 or 1.2 > 
Click OK



LandXML to InfraWorks
Just Import & Configure

§InfraWorks Module > Manage your Model > Data 
Sources
§Add Data Source > LandXML > Select file
§Select Civil object within the LandXML file
§Surfaces will fall under the Terrain group & 
Corridors and Alignments will fall under the Roads 
group
§Design road will not come but the alignment will 
come as centerline



InfraWorks Workflow-06 (IW06):
Civil 3D Drawing to InfraWorks



Civil 3D Drawing to InfraWorks

When you bring Civil 3D alignment, profile 
and corridor data into a model

§ Centreline alignment and profile data 
used to define the component road 
with centreline 

§ Coverage styles to display the areas 
corresponding to the corridor link 
styles

§ Civil 3D corridor comes in as corridor 
surface & coverage

Note: InfraWorks uses predefined style rules 
to map alignment styles to component road 
styles and corridor links to coverage area 
styles. These style rules are based on the 
Autodesk Civil 3D alignment styles and link 
styles included in the standard templates

Things to be mindful of…

The same corridor data brought into InfraWorks, which uses default style rules to 
display the road and coverage areas

A corridor assembly in a Civil 3D drawing, showing its links.



§ Behaviour of Alignment and Profile Entity Types when 
Exchanging Data between Civil 3D and InfraWorks

§ InfraWorks uses predefined style rules to style the 
display of AutoCAD Civil 3D data that translates into 
design roads and associated coverage areas 

§ InfraWorks & Civil 3D uses same material library

Civil 3D Drawing to InfraWorks
Things to be mindful of…

http://help.autodesk.com/view/CIV3D/2019/ENU/%3Fguid=GUID-136BA1C6-E941-47A7-911E-CA92AC502B65


Civil 3D Drawing to InfraWorks

§ Open Drawing “New_Road” & Make 
sure drawing is assigned with 
Projected CS - UTM84-43N

§Confirm Alignments, Corridors & 
Corridors Surfaces names are proper
§Default Code Sets need to apply to 
corridor if you want to see Civil 3D 
corridor/converted coverages with 
materials in InfraWorks

§ Note: You can link this drawing 
directly to InfraWorks or take there 
through IMX or LandXML format

Open drawing in Civil 3D



Civil 3D Drawing to InfraWorks
Insert in InfraWorks

§Click
§Click in the Data Sources panel
§Click > Autodesk Civil 3D DWG > select the 
desired Autodesk Civil 3D drawing, then 
click Open
§Note: A local installation of Autodesk Civil 
3D 2020 is required before you can import 
an Autodesk Civil 3D DWG drawing

https://knowledge.autodesk.com/support/infraworks/learn-explore/caas/CloudHelp/cloudhelp/ENU/InfraWorks-UserHelp/files/GUID-B0CE8D89-F17D-422F-8EF9-DA17838F3CE4-htm.html


Civil 3D Drawing to InfraWorks
Configure “Roads” in InfraWorks

§ InfraWorks converts design 
road & alignment road both to 
a component road and both 
will react as a centerline in 
InfraWorks

§ If you do not have an design 
road but only alignment then 
the road will behave as draped 
on the surface*



Civil 3D Drawing to InfraWorks
Configure Corridor in InfraWorks

§Corridor Surface = Terrain
§Corridor = Coverages



Civil 3D Drawing to InfraWorks
Let’s Configure “Corridor = Coverages” in InfraWorks

§Civil 3D Corridor gets 
converted in InfraWorks 
Coverages if imported 
directly as Civil 3D 
drawing
§You can check what style 
rule are existed in 
InfraWorks for coverages



Civil 3D Drawing to InfraWorks
Let’s Configure “Corridor Surface = Terrain” in InfraWorks

§Civil 3D Corridor surface gets 
converted in terrain surface if 
imported directly as Civil 3D drawing
§You can move if from uncategorized 
to ground surface or at the desire 
level & make sure you switch on the 
layer too



Civil 3D Drawing to InfraWorks
Refresh VS reimport

§Reimport command update the Autodesk Civil 3D 
drawing in your InfraWorks model and reflect design 
modifications. But reimporting the Civil 3D drawing 
will give you duplicate roads if the roads have been 
modified in InfraWorks
§And by chance you have edited the data already then 
as a workaround, you can delete all features of 
selected data source before reimporting it. Else if 
feature is not edited you use just re-import
§Refresh command just reread the data. 
§Reimport function is not available if using IMX in 
InfraWorks as data source. But if you want then You 
can update the IMX file with newer one manually re-
import in InfraWorks.



Question?
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